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1. INTRODUÇÃO 

No âmbito do projeto "Aperfeiçoamento de Ferramentas Estaduais de Gestão de 

Recursos Hídricos no Âmbito do Progestão”, realizado pela parceria entre a Agência Nacional 

de Águas e Saneamento Básico (ANA) e o Instituto de Pesquisa Econômica Aplicada (IPEA), e 

buscando fortalecer a Sala de Alerta da Secretaria de Meio Ambiente e Recursos Hídricos de 

Alagoas (Semarh-AL), foi desenvolvido um modelo hidrológico para a Bacia do Rio Paraíba do 

Meio através do software HEC-HMS. Para tornar o modelo operacional, permitindo com que 

os gestores estaduais realizem previsões em tempo real, algumas ferramentas foram 

desenvolvidas para facilitar a rodada do modelo. Este manual tem objetivo de descrever o 

passo a passo da utilização desses recursos para permitir a operacionalização do modelo pelos 

técnicos da Sala de Alerta da Semarh-AL. 

As ferramentas foram desenvolvidos em linguagem de programação FORTRAN e tiveram 

como base o banco de dados disponível em um Servidor da Semarh-AL, no qual disponibiliza 

em tempo real os dados das estações telemétricas sob responsabilidade da ANA. 

2. INSTALAÇÃO 

2.1. FORTRAN 

Para a utilização das ferramentas em FORTRAN é necessária a instalação de um 

compilador. Considerando que a Semarh-AL utiliza em seus computadores o sistema 

operacional Windows, sugere-se a utilização do compilador gfortran (gfortran.exe) com editor 

Silverfrost FTN95 e IDE Plato (FTN95_personal.exe), que são gratuitos. Os executáveis de 

instalação foram disponibilizados juntamente com o modelo hidrológico e as ferramentas 

para a Semarh-AL, mas também podem ser obtidos através do link: 

https://www.silverfrost.com/32/ftn95/ftn95_personal_edition.aspx. 

Inicialmente, deve-se instalar o FTN95, para isso execute o arquivo FTN95_personal.exe e 

siga os seguintes passos os passos de instalação. Essa instalação já inclui o IDE Plato. Depois, 

execute o arquivo gfortran.exe para instalar o compilador, lembre-se de anotar o caminho da 

pasta onde o compilador foi instalado.  

Para abrir e editar e executar qualquer programa em FORTRAN utilize o Plato, na primeira 

rodada de algum programa uma janela se abrirá perguntando a localização do gFortran (Figura 

1), clique em “Locate” e indique o caminho onde foi instalado o compilador, selecione a pasta 

“bin”. 

 

 

 

https://www.silverfrost.com/32/ftn95/ftn95_personal_edition.aspx
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Figura 1. Janela de localização do compilador aberta pelo Plato 

2.2. HEC-HMS e HEC-DSSVue 

O Hydrologic Modeling System (HEC-HMS) é um software desenvolvido pelo Hydrologic 

Engineering Center do US Army Corps of Engineers (HEC-USACE) que permite simulações 

hidrológicas considerando uma grande variedade de métodos.  

Esse software foi utilizado para desenvolver o modelo hidrológico da bacia do rio Paraíba do 

Meio. Ele está disponível para download gratuito através do link 

https://www.hec.usace.army.mil/software/hec-hms/downloads.aspx. A versão utilizada 

neste manual é a 4.3. 

O HEC-DSSVue é uma interface para facilitar a manipulação dos dados utilizados pelos 

softwares desenvolvidos pelo HEC-USACE, tais como o próprio HEC-HMS. Ele está disponível 

para download gratuito através do link: https://www.hec.usace.army.mil/software/hec-

dssvue/downloads.aspx. A versão utilizada neste manual é a 2.0.1. 

Após o download de ambos os softwares, basta executar o instalador e seguir as janelas. Caso 

haja alguma dificuldade, na página do HEC-USACE também estão disponíveis os manuais dos 

softwares. 

3. FERRAMENTAS 

Foram desenvolvidas três ferramentas em linguagem de programação FORTRAN: 

formatDSS.f95, formatDSSflow.f95 e parametrosHMS.f95, para automatizar a extração dos 

dados necessários para a modelagem hidrológica no HEC-HMS. A seguir será descrito um 

passo a passo de como executar esses programas. 

3.1. Executando o formatDSS.f95 

O programa formatDSS.f95 é responsável por extrair os dados de precipitação 

necessários para o modelo hidrológico do Servidor da Semarh-AL e formatá-los para o HEC-

DSS. Dentro da pasta onde se encontra o programa é necessário ter uma outra pasta com 

nome saida, um arquivo info.txt e um arquivo estacoes.txt (Figura 2). 

https://www.hec.usace.army.mil/software/hec-hms/downloads.aspx
https://www.hec.usace.army.mil/software/hec-dssvue/downloads.aspx
https://www.hec.usace.army.mil/software/hec-dssvue/downloads.aspx
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Figura 2. Pasta onde se encontra o programa formatDSS.f95 com os demais arquivos necessários 

O arquivo info.txt disponibiliza as seguintes informações necessárias para o programa: 

caminho da pasta com os dados das estações telemétricas e data que se deseja iniciar a 

previsão de vazão. O formato do arquivo deve seguir o modelo da Figura 3. 

 
Figura 3. Informações disponibilizadas pelo arquivo info.txt 

O arquivo estacoes.txt disponibiliza informações sobre as estações com dados de chuva que 

serão utilizadas na modelagem hidrológica, tais como: código da estação; nome reduzido da 

estação (atenção: esse nome não pode conter nem espaços e nem caracteres especiais); 

minuto em que os arquivos são armazenados; e nome original da estação. A última informação 

não é utilizada pelo programa e pode ser dispensada. O formato do arquivo deve seguir o 

modelo da Figura 4. 
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Figura 4. Informações disponibilizadas pelo arquivo estacoes.txt 

Para executar o programa, abra o formataDSS.f95 no Plato e selecione a opção “Release x64” 

(Figura 5). Em seguida, rode o programa através do “Build > Start Run” (Figura 6) ou pressione 

“Ctrl+F5”. O “Prompt de Comando” irá se abrir e executar o programa, caso não ocorra 

nenhum erro, uma mensagem irá aparecer conforme a Figura 7. Pressione “Enter” para fechar 

a janela. Atenção, evite fazer alterações no código. 

 
Figura 5. Programa formatDSS.f95 aberto no Plato e seleção da opção Release x64 
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Figura 6. Rodando o programa formatDSS.f95 

 
Figura 7. Execução do formatDSS.f95 no Prompt de Comando 

As saídas do programa serão armazenadas na pasta saida em formato texto, na qual estarão 

disponíveis os dados de chuva de cada estação no formato HEC-DSS, identificadas através do 

código da estação (Figura 8). Também é gerado um arquivo preenchidos.txt, que indica os 

dados que estavam ausentes no banco de dados e que foram preenchidos com chuva nula 

(Figura 9).  

Quando esse arquivo está vazio, significa que todos os dados foram encontrados e não foi 

necessário realizar nenhum preenchimento. Porém, atenção, caso um grande número de 

datas apareça nesse arquivo é necessário verificar se realmente esses dados não existem no 

Servidor e avaliar a possibilidade de retirar a estação da simulação. 
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Figura 8. Arquivos gerados pelo formatDSS.f95 

 
Figura 9. Exemplo de arquivo preenchidos.txt 

Para cada estação é gerado um arquivo no formato HEC-DSS, conforme exemplificado na 

Figura 10. As datas consideradas são 5 dias antes e 3 dias depois da data de previsão. 

Considerando o funcionamento operacional do modelo, provavelmente, não haverá dados de 

chuva observada 3 dias depois da data de previsão escolhida, sendo necessário utilizar dados 

de chuva prevista.  

Inicialmente, será adotado a previsão de chuva nula, ou seja, todos os dados de chuva 3 dias 

depois da previsão são considerados zero. Posteriormente, quando a Semarh-AL tiver 



                                                                                                       

Manual do Modelo Operacional – ALAGOAS                                                                                                                      9 

disponível dados de chuva prevista na escala horária e em tempo real, o programa pode ser 

adaptado para utilizar esses dados. Uma das sugestões é utilizar os dados do radar 

meteorológico. 

 
Figura 10. Exemplo de arquivo gerado pelo formatDSS.f95 no formato HEC-DSS 

3.2. Executando o formatDSSflow.f95 

O programa formatDSSflow.f95 é responsável por extrair os dados de cota do Servidor 

da Semarh-AL, transformá-los em dados de vazão a partir da curva-chave das estações 

fluviométricas utilizadas pelo modelo hidrológico e formatá-los para o HEC-DSS. Lembrando 

que, as estações fluviométricas utilizadas pelo modelo são: Vila São Francisco (39852000); 

Viçosa (39860000) e Atalaia (39870000). Dentro da pasta onde se encontra o programa é 

necessário ter uma outra pasta com nome saida e um arquivo info.txt (Figura 11). 

 

Figura 11. Pasta onde se encontra o programa 
formatDSSflow.f95 com os demais arquivos necessários 

O arquivo info.txt, além de disponibilizar as mesmas informações utilizadas pelo 

programa formatDSS.f95 (caminho da pasta com os dados das estações telemétricas e data 

que se deseja iniciar a previsão de vazão), também disponibiliza o valor de Offset de cada 

estação. O Offset é a diferença entre a cota de referência da curva-chave e a cota lida pelo 
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sensor da estação telemétrica. A princípio, esses valores são considerados como zero, o que 

significa que os dados da telemetria estão alinhados com a referência de cota da curva-chave. 

O formato do arquivo deve seguir o modelo da Figura 12. 

 
Figura 12. Informações disponibilizadas pelo arquivo info.txt 

Para executar o programa, basta seguir o mesmo procedimento utilizado para o 

formatDSS.f95, ou seja, abra o formatDSSflow.f95 no Plato, selecione a opção “Release x64”, 

rode o programa através do “Build > Start Run” ou pressione “Ctrl+F5”. O “Prompt de 

Comando” irá se abrir e executar o programa, caso não ocorra nenhum erro, uma mensagem 

irá aparecer conforme a Figura 7. Pressione “Enter” para fechar a janela. 

As saídas do programa serão armazenadas na pasta saida em formato texto, na qual estarão 

disponíveis os dados de vazão de cada estação fluviométrica no formato HEC-DSS, 

identificadas através do código da estação seguido da palavra “flow” (Figura 13).  

Também é gerado um arquivo ausentes.txt, que indica os dados que estavam ausentes no 

banco de dados e que foram preenchidos com vazão nula. Quando esse arquivo está vazio, 

significa que todos os dados foram encontrados e não foi necessário realizar nenhum 

preenchimento. 

 

Figura 13. Arquivos gerados pelo formatDSSflow.f95 
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Para cada uma das três estações fluviométricas é gerado um arquivo no formato HEC-DSS, 

conforme exemplificado na Figura 14. As datas consideradas são 5 dias antes da data de 

previsão. 

 
Figura 14. Exemplo de arquivo gerado pelo formatDSSflow.f95 no formato HEC-DSS 

3.3. Executando o parametrosHMS.f95 

Além dos dados de precipitação, o modelo hidrológico também precisa de alguns 

parâmetros que são variáveis dependendo da vazão inicial da simulação e da chuva 

antecedente. Por isso, foi criado o programa parametrosHMS.f95, responsável por obter 

esses parâmetros e disponibiliza-los de forma fácil para o técnico. 

O programa irá extrair do banco de dados a cota observada no primeiro instante de simulação 

e transforma-la em vazão a partir da curva-chave da estação. As três estações fluviométricas 

utilizadas pelo modelo são: Vila São Francisco (39852000), Viçosa (39860000) e Atalaia 

(39870000). Essas vazões e a diferença entre elas são utilizadas no parâmetro Initial Discharge. 

No caso do parâmetro Initial Range, cada estação possui um cálculo diferente. Para Vila São 

Francisco, o Initial Rage é obtido com base no Initial Discharge. Já para Viçosa, o Initial Rage 

é relacionado com a chuva acumulada 48 horas antes do início da simulação - tal informação 

também é extraída do banco de dados pelo programa. Inicialmente, para Atalaia o Initial Rage 

é constante e possui o valor 40. Atenção, deve-se atentar com as mudanças de off-set dos 

dados de cota, para evitar cálculos errados de vazão. 
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Dentro da pasta onde se encontra o programa parametrosHMS.f95 é necessário conter o 

arquivo info.txt, que é o mesmo utilizado pelo formatDSSflow.f95 (Figura 12).  

Para executar o programa, basta seguir o mesmo procedimento utilizado para o 

formatDSS.f95, ou seja, abra o parametrosHMS.f95 no Plato, selecione a opção “Release 

x64”, rode o programa através do “Build > Start Run” ou pressione “Ctrl+F5”. O “Prompt de 

Comando” irá se abrir e executar o programa, caso não ocorra nenhum erro, uma mensagem 

irá aparecer conforme a Figura 7. Pressione “Enter” para fechar a janela. 

O programa irá gerar na mesma pasta os arquivos InitialDischarge.txt e InitialRange.txt. O 

primeiro apresenta os parâmetros Initial Discharge para as três estações fluviométricas 

utilizadas pelo modelo hidrológico (Figura 15) e o segundo os parâmetros Initial Range (Figura 

16).  

Em alguns casos, os valores serão expressos com o valor -999.999 e acompanhamos com uma 

observação do motivo da ausência de informação. Na ausência de informação caberá ao 

técnico definir qual será o valor dos parâmetros. 

 
Figura 15. Exemplo de arquivo InitialDischarge.txt gerado pelo programa parametrosHMS.f95 

 

Figura 16. Exemplo de arquivo InitialRange.txt gerado pelo programa parametrosHMS.f95 
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4. ARMAZENAMENTO DE DADOS NO HEC-DSSVue 

Após extraídos os dados de chuva e vazão necessários para a modelagem hidrológica, 

os mesmos precisam ser carregados no HEC-DSSVue para serem importados pelo HEC-HMS. 

Para isso, abra o HEC-DSSVue e abra o arquivo DSS de nome ParaibaOperacao.dss, que foi 

disponibilizado junto com do modelo hidrológico de operação do Paraíba do Meio 

(ParaibaOperacao), através do “File > Open...” (Figura 17).  

Os dados da última operação estarão armazenados nesse arquivo DSS. Para iniciar uma nova 

operação, selecione e exclua todos os dados através do “Edit > Delete Records” (Figura 18). 

Importe os arquivos gerados pelo formatDSS.f95 e pelo formatDSSflow.f95 de todas as 

estações através do “Data Entry > Import > Dssutl Write Data File” (Figura 19).  

Após importados todos os dados, eles podem ser verificados utilizando-se as ferramentas do 

HEC-DSSVue. Para isso, basta selecionar as estações desejadas e clicar nos ícones disponíveis 

(Figura 20). 

 
Figura 17. Abrindo o arquivo ParaibaOperacao.dss do modelo de operação do Paraíba do Meio 
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Figura 18. Excluindo dados da última operação 

 
Figura 19. Importando dados para HEC-DSSVue 
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Figura 20. HEC-DSSVue após importação 

5. SIMULAÇÃO NO HEC-HMS 

Agora com o banco do HEC-DSS preparado é momento de rodar o modelo hidrológico 

no HEC-HMS. Para isso, abra o HEC-HMS e abra o projeto de operação do Paraíba do Meio, de 

nome ParaibaOperacao.hms, através do “File > Open... > Browse” (Figura 21). 
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Figura 21. Abrindo o projeto ParaibaOperacao.hms no HEC-HMS 

Nesse projeto já estão definidos os parâmetro fixos e a estrutura do modelo hidrológico do 

Paraíba do Meio. Porém, é necessário atualizar algumas informações para a nova previsão.  

Primeiramente, atualize as datas de simulação do modelo no “Control Specifications > Control 

1” (Figura 22). Infelizmente, também será necessário atualizar as datas das estações que serão 

utilizadas. Para isso, clique em “Time-Series Data > Precipitation Gages”, nesse local estão 

armazenadas todas as estações pluviométricas que podem ser utilizadas pelo modelo 

hidrológico. Selecione, estação por estação, com o botão direito do mause e clique em “Create 

Time Window”, selecione a opção “Control 1” no primeiro item e clique em “Add” (Figura 23).  

Posteriormente, exclua a antiga janela de tempo clicando sobre a mesma com o botão direito 

do mause e selecionando “Delete Time Window” (Figura 24). O mesmo procedimento também 

deve ser realizado para os dados de vazão, que estão disponíveis em “Time-Series Data > 

Discharge Gages”. 
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Figura 22. Atualização das datas no Control Specifications do HEC-HMS 

 
Figura 23. Atualização da janela de tempo das séries de precipitação no HEC-HMS 
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Figura 24. Excluindo a antiga janela de tempo no HEC-HMS 

Agora, é necessário atualizar os parâmetros variáveis do modelo, que são o Initial Range e o 

Initial Discharge. Para isso, expanda o componente “Basin Models” e selecione “Paraiba”, será 

possível verificar a estrutura do modelo hidrológico. Clique sobre um dos elementos de sub-

bacia e depois na aba “Loss”, substitua o valor de “Initial Range (MM)” pelo valor encontrado 

pelo programa parametrosHMS.f95, disponível no arquivo InitialRange.txt (Figura 25). Na 

aba Baseflow substitua o valor de “Initial Discharge (M3/S)” pelo valor disponível no arquivo 

InitialDischarge.txt (Figura 26). Realize o mesmo procedimento para os três elementos de 

sub-bacia: “VSaoFran”, “VicosaInc” e “AtalaiaInc”. Salve as alterações. 
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Figura 25. Atualização do parâmetro Initial Range no HEC-HMS 

 
Figura 26. Atualização do parâmetro Initial Discharge no HEC-HMS 
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Caso se deseje excluir da simulação algumas das estações de precipitação, expanda o 

componente “Meteorologic Models” e selecione “Met 1” e depois “Precipitation Gages”. Na 

coluna “Use Gage” mude de “Yes” para “No” nas estações que não devem participar da 

simulação (Figura 27). Salve as alterações. 

 
Figura 27. Determinação das estações de precipitação deverão participar da simulação no HEC-HMS 

Finalmente, com todas as informações atualizadas, para dar início a simulação, abra a aba 

“Compute”, expanda o “Simulation Runs”, clique com o botão direito do mause sobre “Run 1” 

e clique em “Compute” (Figura 28). Quando finalizada a simulação, feche a janela clicando em 

“Close” e analise os resultados na aba “Results”. 



                                                                                                       

Manual do Modelo Operacional – ALAGOAS                                                                                                                      21 

 
Figura 28. Iniciando a simulação no HEC-HMS 

6. CONSIDERAÇÕES 

Os programas em FORTRAN disponibilizados como ferramentas considera a estrutura 

do Servidor da Semarh-AL, que atualmente armazena os dados disponibilizados pela ANA via 

ftp. Em caso de mudança no formato de disponibilização dos dados, esses programas deverão 

ser alterados ou um novo programa pode ser criado para formatar os dados conforme o 

Servidor da Secretaria. 


